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Introduction 

Summary 
DynacCommand is the control centre for the DynacTools suite offering 
planning, budgeting, forecasting, and financial reporting capabilities.  For 
more information about the suite, refer to DynacTools Overview. 

 
Figure 1 – DynacTools application modules 

DynacCommand is an optional module that acts as a control centre for the 
other application modules. 

For a general introduction to the DynacTools concepts, refer to the document 
DynacTools Overview. 

Features 
DynacCommand is a control centre that enables you to manage DynacTools 
implementation and applications.  It facilitates the process of defining your 
companies, user accounts, and the relationship between your accounting 
system accounts and the Dynac Chart of Accounts (CoA). 

Using DynacCommand you can perform these tasks: 
• Define your entity and consolidation companies. 
• Define and manage the relationship between accounts using Dynac 

Account Manager. 
• Define your users and their access to the entities and consolidations. 
• Define, run, and trigger events, either immediately or on a pre-defined 

schedule. 
• Open DynacTools files and applications. 
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• Update the DynacTools software through a website connection. 

Concepts 

Companies 

In DynacTools, a company structure is developed from one or more entities 
that can be grouped into consolidated entities. 
• An entity (ET) represents any legal accounting set of books.  It can 

represent a division of a company, a company, or an entire enterprise 
organization.  An entity is the smallest Dynac building block.  Each entity 
must be related to an existing accounting package or database from 
which it can extract your accounting data. 

• A consolidated entity represents a grouping of entities for reporting 
purposes.  A consolidated entity does not connect directly to your 
accounting data – it obtains all its data from the entities that report to it.  
In Dynac terminology, a consolidated entity is called a headquarters (HQ). 

• In Dynac terminology, a company is any entity or consolidated entity. 
• In database terminology, a consolidated entity is called a parent; an entity 

is called a child. 

Note Consolidated entities are available only with the DynacConsolidator module. 

Company Structure 
In the simplest structure, you need to define only one or more entities. 

Figure 2 – Basic entity structure 

Using DynacConsolidator, you can establish a reporting hierarchy to 
consolidate results at successively higher levels.  You can choose to 
consolidate the entity values at any level of detail or summary.  A typical 
consolidation structure is illustrated in following figure. 
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Figure 3 – Typical consolidation structure 

DynacConsolidator offers complete flexibility to define any consolidation 
strategy to suit your circumstances.  For example, you can consolidate both 
entities and other consolidations, as illustrated in following figure. 

Figure 4 – Mixed consolidation structure 

You can restrict access to various entities or consolidations to certain users.  
Figure 5 illustrates both a hierarchy-based consolidation structure and a 
parallel user-oriented consolidation structure. 
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Figure 5 – Parallel consolidation structures 

In this structure, there is an orphan consolidation level that exists for reporting 
purposes only. 

Company Data Requirements 
Each company requires specific information.  The data requirements are 
summarized in the following table. 
 

Item Description 

company ID unique identifier (that is, the identifier cannot be the 
same as an existing company identifier) 

company name name displayed in Dynac lists of companies and in 
report headers 

consolidated 
indicator 

indicator for whether the company is or is not a 
consolidated entity 

database 
connection 

information required for connecting to the Dynac 
database and the accounting system 

templates folder location of the company template files 

Note The database connection uses the ODBC protocol.  If your accounting 
system does not support an ODBC connection, the data can be transferred 
using data files created by your accounting system.  For information about 
this data transfer option, contact Dynac Professional Services. 

When assigning company IDs, consider developing a naming convention that 
will suit both current and future structures.  Possibly, you may want to use the 
same ID used in your accounting system. 
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The company ID can be a maximum of 10 letters and numbers.  It cannot 
contain spaces but it can contain dash (“-”) and underscore (“_”) characters. 

Tip Although the company ID can be as many as 10 alphanumeric characters, 
Dynac recommends that you keep it as simple as possible (say, 4 or 5 
characters). 

For example, for the company structure illustrated in Figure 3 that has both 
U.S. and Canadian operations consolidated at two levels, a possible naming 
convention could be: 
• Entities: “USD1”, “USD2”, “USD3”, “CAD1”, “CAD2”, and “CAD3” 
• Consolidation Level 1: “USDc” and “CADc” 
• Consolidation Level 2: “ALLc” 

where the “c” suffix indicates a consolidated company. 

When a new company is created, you define the location for its template files.  
Dynac mandates that you define a separate folder for each company. 

Typically, a company’s templates are located in the folder 
C:\DynacTools\Companies\AAAA, where AAAA is a name that you 
specify when you create a new company.  Dynac recommends that you use 
the company ID.  For example, if you create a company with the ID ALLc, 
you could use the same identifier for its templates folder: 
C:\DynacTools\Companies\ALLc.  If you prefer a more descriptive 
folder name, use the company name (for example, ALL_consolidated). 

User Accounts 

Security and confidentiality are always important considerations for your 
financial data.  In fact, they are legal requirements.  Therefore, 
DynacCommand provides you with the means of controlling who can perform 
certain tasks and who can see the various entities and consolidations. 

There are two groups of users: 
• Administrator 
• User 

A user account with Administrator privileges is allowed to perform any task in 
DynacTools.  There can be multiple Administrator accounts. 

A User account has these restrictions: 
• Cannot manage the company information such as creating or deleting 

companies. 
• Cannot manage user accounts. 
• Cannot update the DynacTools software. 

An Administrator defines which companies each User can access.   

Your DynacTools installation includes one Administrator account.  The default 
username is admin and there is no password. 
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Note Add a password immediately to the default Administrator account.  
Refer to Editing an Existing User Account on page 30. 

Tip Always use strong passwords.  A strong password should appear to be a 
random string of characters.  It should be at least 8 characters long and 
contain both characters and digits.  However, do not use combinations of 
dictionary words and digits representing dates.  The password can include 
spaces and special characters. 
Microsoft offers an online service that checks the strength of a password at  
http://www.microsoft.com/protect/yourself/password/checker.mspx  

Tip Limit the use of the admin account to the person responsible for managing 
the DynacTools system.  If necessary, you can create additional administrator 
accounts. 

Chart of Accounts 

The Dynac Chart of Accounts (CoA) feature enables you to develop a 
reporting structure to display trial balance data in a meaningful way. 

Dynac uses the term mapping to describe the process by which a G/L 
account from your accounting system (that is, a posting account) is linked, or 
mapped, to a summary account in the DynacTools CoA reporting structure. 

The concept of mapping is that each account in a “source” is linked to an 
account in a “target”. 
• For an entity, the source is your accounting system and the target is a 

Dynac entity. 
• For a consolidated company, the source is multiple Dynac entities and the 

target is a Dynac consolidated company.  However, because Dynac 
allows multiple levels of consolidation, as the consolidation hierarchy is 
expanded, the source can also be both multiple Dynac entities and 
multiple Dynac consolidated companies, as illustrated in Figure 4. 

CoA Structure 
In most accounting systems, each posting account is independent.  Some 
accounting systems include a reporting structure and, in DynacTools, you can 
either maintain that structure or reorganize it. 

Using DynacTools Account Manager, you can organize and structure posting 
accounts.  To use a physical analogy, your accounting system shows you 
only a pile of leaves (posting accounts); the Dynac CoA displays a tree-limb-
branch-leaf indented reporting structure as illustrated in following figure. 
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Figure 6 – Mapping posting accounts to a Dynac CoA 

Dynac provides two sample Chart of Accounts template files, as illustrated in 
following figure. 

Figure 7 – Sample Charts of Accounts 

The sample files are named COA1.coa and COA2.coa and they are 
located in the C:\DynacTools\Templates folder. The files are text files 
that can be opened using Windows Notepad.  You can use the sample files 
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as a starting point to further define your own CoA structure.  For an 
explanation of the file format, review the text file COA.txt located in the 
templates folder. 

Note Before attempting to develop your own template, contact Dynac Professional 
Services to discuss your requirements. 

The Dynac CoA structure allows you to define a report structure with multiple 
reporting levels.  The Dynac CoA structure provides three items: 
• Header level 
• Summary level 
• Cumulative translation adjustment (CTA) account 

The concept is illustrated in following figure. 

 
Figure 8 – Dynac CoA structure 

There can be an unlimited number of header levels.  However, as illustrated 
in the sample CoAs in Figure 7, there must be a header for each RELAQ 
group (that is, one header for each of Revenues, Expenses, Liabilities, 
Assets, and Equities).  Other headers are used to group user defined 
statistical accounts. 

For each header level, there can be an unlimited number of summary levels. 

Within each of the Income Statement and the Balance Sheet sections, there 
can be only one CTA account.  Therefore, there can be only two CTA 
accounts for the company (one for the Income Statement and one for the 
Balance Sheet). 

Note For a consolidated company, there must be at least one CTA account 
somewhere in the Chart of Accounts. 
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Posting accounts are mapped from your accounting system to a Summary 
level.  Posting accounts cannot be mapped to Header levels. 

CoA RELAQ Classification 
During the mapping process between your accounting system and the Dynac 
CoA, each item is appropriately classified as an expense, a revenue, an 
asset, a liability, or an expense, as illustrated in the following figure. 

 
Figure 9 – RELAQ classification system 

Dynac refers to this classification as “RELAQ”, simply because this 
combination of letters can be pronounced easily.  Therefore, you may hear 
Dynac Support talk about “RELAQing” the data. 

You create a Chart of Accounts in DynacTools by mapping each posting 
account from your accounting system and identifying its reporting hierarchy 
with its RELAQ classification.  When mapping posting accounts, you are 
allowed to flip them within the Income Statement or Balance Sheet (for 
example, between Expense and Revenue, and vice versa).  However, you 
are not allowed to map accounts from the Income Statement to the Balance 
Sheet, or vice versa. 

CoA Parameters 
The reporting levels are defined by parameters. 

The two primary parameters are an identifier and description. 
• ID (for example “2”, “2.1”, “2.1.1” , “2.1_a”)) 
• Description (for example, “HEADER level”, “SUMMARY level”, “CTA 

account” 

The ID can be any string of characters and digits.  However, every ID must 
be unique – it cannot be the same as any other ID, even if they are different 
types of accounts. 

A Header ID can include spaces.  Summary and CTA IDs cannot include 
spaces.  However, all IDs can include decimal (“.”), dash (“-”), and 
underscore (“_”) characters. 
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Tip Avoid using IDs that Excel can interpret as a decimal number ending in zero 
(for example, “1000.10”) or a date (for example, “1000-10-5”) because 
DynacBudget then needs to run iin Precise Mode which reduces calculation 
performance. 

Additionally, each account is identified by other parameters as illustrated in 
the following figure. 

 
Figure 10 – Chart of Accounts parameters 

The parameters are explained in the following table. 
 

Parameter Description User Editable Note 
Reports To Header or Summary 

level that the account 
is included in 

No.  However, it can be 
changed by moving the 
account to a different 
parent. 

1. 

RELAQ RELAQ classification No; it is assigned when 
the account is created.  
However, it can be 
changed by moving the 
account to a different 
parent. 

2. 
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Parameter Description User Editable Note 
Department Department ID No.  It is assigned in 

DynacForecast for 
Accounts.

3. 

Style Display style in 
DynacBudget

Yes 4. 

Cash Flow Cash flow account 
code 

Yes 5. 

Class Type of account No.  It is assigned 
automatically based on 
the type of account 

6. 

Locked Indicates if the 
account is locked 
and cannot be 
updated 

No.  But, it can be 
changed within 
DynacBudget. 

7. 

Imported 
From 

Data source No.  It is assigned 
automatically based on 
account source. 

8. 

Notes: 

1. The Reports To field is not applicable to Header accounts and the first 
level of Summary accounts because their reporting parent is implied by 
their position in the CoA hierarchy.  For other accounts, the value is 
assigned automatically based on the position of the account in the CoA 
hierarchy  

2. The RELAQ code is inherited from its parent when the account is created 
or mapped.  If you create a new Header level manually, you are prompted 
for its RELAQ code. 

3. The Department code is used only by DynacForecast for Accounts. 

4. For a list of Style codes, refer to Default Styles on page 53. 

5. For a list of Cash Flow accounts, refer to Default Cash Flow Accounts on 
page 52. 

6. The Class codes are 
• H – Header level 
• S – Summary level 
• P – Posting account 
• D – Dynac-specific account 

7. The Locked codes are 
• L – Locked (that is, the account value for Opening cannot be updated) 
• O – Open (that is, the account value for Opening can be updated) 

Typically, the locking feature is used annually when you are preparing 
new Fiscal Year DynacBudget templates.  When a Fiscal Year is rolled 
forward to a new year, you can edit, then lock, the Current and Retained 
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Earnings accounts until the final G/L values are available in the 
accounting system. 

8. The Imported From field indicates the source of the data.  For posting 
accounts, the field displays DYNTB (Dynac Trial Balance).  For 
consolidated companies, the field displays the appropriate company ID.  
A blank field indicates that the account is unique to the Dynac CoA (that 
is, it was not mapped from a source). 

CoA Organization Principles 
When you create the Dynac CoA, these rules are enforced: 
• Header levels must report to the main company level.  In the Chart of 

Accounts pane, the uppermost level is illustrated with the  icon and is 
identified by its company ID. 

• CTA accounts must report to a Summary level. 
• As a minimum, the CoA hierarchy must contain five Header levels: 

• Assets (A) 
• Liabilities (L) 
• Equities (Q) 
• Revenues (R) 
• Expenses (E) 

If you add additional Header levels for statistical accounts, they must be 
grouped with existing Headers with the same RELAQ code.  For example, 
if you create another Liability Header, you must position it adjacent to an 
existing Liability reporting level. 

Warning When you create a new Header level, you are allowed to position it 
where it could violate the preceding rule.  However, if the Headers 
are not grouped correctly, you cannot save the new data to the 
database (see error message illustrated in Figure 11).  Therefore, 
when you move or create Headers, be very careful that all accounts 
with the same RELAQ classification are positioned together. 

 
Figure 11 – Invalid arrangement of Header levels 

When you map accounts from your accounting system (that is, posting 
accounts) to the Dynac CoA, these rules are enforced: 
• Accounts must be attached to a Summary level; they cannot be attached 

to a Header level. 
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• You can flip accounts within the Income Statement or Balance Sheet 
although you will receive a warning before you can proceed. 

• You cannot map accounts from the Income Statement to the Balance 
sheet, and vice versa. 

Note The mapping rules are also enforced when reorganizing accounts within the 
Dynac Chart of Accounts. 

CoA Mapping Principles 
The mapping process is performed using DynacCommand Account 
Manager.  There are two implementations: 
• Dynac (Entity) Account Manager for mapping posting accounts to a 

Dynac entity. 
• Dynac (Consolidated) Account Manager for mapping entity and 

consolidated company accounts to a higher-level consolidated company. 

Entity 
For an entity, the mapping concept is that each posting account in your 
accounting system must be linked to a Summary account CoA in the Dynac 
entity.  Every posting account must be linked; otherwise, the entity’s 
DynacBudget cannot be assured of balancing. 

In Account Manager the mapping process is illustrated visually using two 
panes: Unmapped Accounts (the source) and Chart of Accounts (the 
target). 

Before you start the mapping process, all the posting accounts are displayed 
in the Unmapped Accounts pane, as illustrated in the following figure. 

 
Figure 12 – Entity accounts before mapping 
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When you complete the mapping process, all the posting accounts should be 
displayed in the Chart of Accounts pane, as illustrated in the following 
figure. 

 
Figure 13 – Entity accounts after mapping 

To use the tree-limb-branch analogy mentioned previously, the Unmapped 
Accounts pane displays only leaves whereas the Chart of Accounts pane 
displays the leaves hanging on a tree. 

Consolidated Company 

Note The consolidation feature is available only if you purchased the 
DynacConsolidator module. 

For a consolidated company, the mapping concept is that each account in the 
Dynac source companies must be linked to a Summary account in the Dynac 
target consolidation company.  Every account must be linked; otherwise, the 
consolidated company’s DynacBudget cannot be assured of balancing. 

However, unlike entity mapping, the source accounts have a structure.  
Therefore, when you consolidate accounts, you can choose the level of detail 
that you want to display for the consolidated company’s various accounts. 

There are two approaches: 
• You can maintain the details of the posting accounts, as illustrated in the 

following figure. 
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Figure 14 – Mapping consolidation accounts at the detail level 

In this example, one cash account (1000-CDN) from the Canadian 
company is mapped to the CoA and one cash account (1005-CDN) is not 
mapped. 

Note that Account Manager automatically appends the company ID to all 
the entity account IDs so that you can easily determine the source of 
each.  If the account is consolidated at higher levels, the identifier is 
extended accordingly.  For example, if this consolidated company, with 
company ID CONS, is consolidated into another company, its account IDs 
will be appended with -CDN-CONS. 

Note As it is illustrated in Figure 14, the mapping process is incomplete.  To 
ensure that the consolidated company will balance, the remaining cash 
account from the Canadian company (1005-CDN) must be mapped to the 
Chart of Accounts pane.  Therefore, if you want the details in the 
consolidated company, you must keep the details for all the other 
accounts within the same summary level.  Or, you can change the CoA 
structure in the entity to separate those accounts for which you need to 
carry the detail from other accounts for which you do not need to carry the 
detail. 

• You can eliminate the detail and map a summary account to the 
consolidated company. 

For example, the summary account 1.1.1-CDN can be mapped.  Although 
the account is a branch in the source entity, it becomes a leaf in the 
consolidated company, as illustrated in the following figure. 
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Figure 15 – Mapping consolidation accounts at the summary level  

Note When you map a summary account, Account Manager reminds you that 
any child accounts will be unmapped. 

 
Figure 16 – Mapping reminder 

When an account is unmapped, it is not lost – its data still resides in the 
database.  However, its data is no longer reported individually – it is 
reported for the account that it is part of.  For the example in Figure 15, 
after the 1.1.1-CDN summary account has been mapped to the Chart of 
Accounts pane, you cannot see its child accounts 1000-CDN and 1005-
CDN.  However, the values that you see for 1.1.1-CDN in DynacBudget 
are the total, or consolidated, values from the two child accounts. 

To restore the child accounts: 

1. Unmap the parent account (for example, 1.1.1-CDN) in the Chart of 
Accounts pane. 

2. Save the CoA. 

3. Load the CoA. 

The child accounts will now be visible in the Unmapped Accounts pane. 
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Figure 17 – Child accounts revealed 

Scheduler 

The Scheduler facilitates repetitive data manipulation actions.  After defining 
an action, you can either automate its execution or you can run it on demand 
(that is, immediately). 

An event is a single action.  Individual actions can be grouped into a set of 
events.  The grouping serves two purposes: 
• organization 

You can label the group as a reminder of when you should perform the 
task (for example, Monthly, Weekly, Daily). 

• efficiency 
You can run the set of events rather than running each event individually. 

Also, by appropriately organizing the events within a group, the grouping 
serves as a reminder about the order that you need to run the events. 

Typically, an event can perform one of these tasks. 
• Import chart of accounts (CoA) from an entity 
• Import display ledger (D/L) data from an entity 
• Import general ledger (G/L) data from your accounting system. 
• Transfer high level budget (HLB) data to an entity. 
• Auto mapping (where account mapping structure is clearly defined). 

Note Other types of events can be developed by Dynac.  Contact Dynac 
Professional Services to discuss your requirements. 
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Information can be transferred between an entity (ET), a consolidated 
company (HQ), and your accounting system.  Each event transfers 
information from a source to a target. 
 

Event Source Target 

Import COA from entity ET HQ 

Import DL from entity ET HQ 

Import GL from accounting system accounting 
system ET 

Transfer HLB data to entity HQ ET 

When data is combined from multiple entities to a consolidated company, you 
should always create two events for each entity and execute them in this 
order: 

1. Import COA from entity 

2. Import DL from entity 

It is important that both CoA and D/L data is always imported to ensure that 
there have not been new accounts created in the entity that require mapping.  
Otherwise, the D/L data import for any new accounts in the entity that do not 
exist in the consolidated company will not be displayed. 

Note You must create at least one set of events before you can create an event.  
That is, in database terminology, a set of events is a parent and an event is a 
child.  Therefore, each event (child) must have a set of events (parent) to 
which it is related. 

For the sample organization illustrated previously in Figure 3, possible 
actions include importing the original G/L data from your accounting system 
and consolidating the results at two levels.  Those actions could be organized 
as illustrated in the following figure. 
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Figure 18 – Sample events 

Note As illustrated in the preceding figure, you can (and should) edit event names 
to make them more informative. 

You can run a specific event or a set of events.  If you run a set of events, the 
child events are run in the order in which they are listed below the parent 
event.  For example, for the events illustrated in Figure 11, if you run the Top 
Level Consolidation set of events, it will first import the D/L data from 
USDc to ALLc then it will import the D/L data from CADc to ALLc. 

While the events are running, the results are written to a log file 
C:\DynacTools\Events.log.  If the log file does not already exist, it is 
created.  If the log file already exists, the new results are appended to the 
end of the previous results.  Therefore, to view the latest results, scroll down 
to the bottom of the file. 

Tip To ensure that the log file does not grow to an unmageable size, you should 
develop a procedure to either delete the file or rename it to maintain the 
complete log history.  For example, at the end of each month, you could 
rename the file from Events.log to EventsYYYYMM.log. 
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DynacCommand User Interface 

During the DynacTools installation procedure, you can add a 
DynacCommand shortcut on your desktop. 

 
Figure 19 – DynacCommand desktop icon 

To start DynacCommand, double-click the shortcut to display the Dynac 
Command window. 

DynacCommand Window 
The DynacCommand window has four areas: 
• main menu 
• list of companies 
• window operation buttons 
• list of company templates 

Figure 20 – DynacCommand window 

The list of company templates is displayed only after a company is selected 
from the list, as illustrated in the following figure. 

DynacCommand User Guide  20 



Introduction
 

 
Figure 21 – DynacCommand window with company templates 

DynacCommand Run Option 
The DynacCommand main menu includes a Run option that provides a 
convenient way to launch other applications.  The applications can be 
anything that you typically run in conjunction with your budgeting, planning, 
forecasting, and financial reporting tasks.  The Run menu simply offers a 
convenient place to centralize all the tasks. 

For example, while running DynacTools, if you also run an accounting 
application and you also open a particular spreadsheet, those two tasks can 
be added to your DynacCommand menu, as illustrated in the following figure. 

Figure 22 – DynacCommand customized Run menu 

The description for the applications can also be personalized. 

Note The Run menu must be customized for each installation by Dynac 
Professional Services. 
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Tasks 
There are two task categories: 
• User tasks – accessing DynacBudget and DynacViews templates and 

organizing their CoA. 
• Managing Template Files on page 23 
• Administering Chart of Accounts on page 31  
• Scheduling Events on page 41  
• Obtaining Help on page 50  

• Administrator tasks – managing your DynacTools setup. 
• Administering the Company Structure on page 23  
• Administering User Accounts on page 29  
• Updating DynacTools Software on page 48  

Running DynacCommand  
If you are not familiar with running DynacCommand, refer to DynacCommand 
User Interface on page 20. 

Starting DynacCommand  

To start DynacCommand: 

1. On the desktop, double-click the DynacCommand icon. 

2. In the Login dialog box, do the following: 
i. In the Username field, type your login ID. 
ii. In the Password field, type your password. 
iii. Click OK. 

Tip Simplify Step 2 by using only the keyboard.  First, type your login ID, and 
press the Tab key.  Then, type your passoword and press the Enter key. 

Stopping DynacCommand  

To stop DynacCommand: 

1. On the main menu, choose File > Exit. 

Note Some tools must be closed before you can access the main menu.  These 
tools are Companies, Users, and Scheduler. 
The Account Manager tool runs independently and keeps running when 
DynacCommand is stopped. 
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Managing Template Files 

Note As a user, you may not see all the entities or consolidated companies.  If 
DynacCommand does not display a company that you expect to see, contact 
your Dynac Administrator. 

Opening an Existing Template 

To open an existing DynacBudget or DynacViews template: 

1. On the left side of the window, select a company to display its list of 
templates in the pane on the right side of the window. 

2. Click a template name, then click Open. 

Creating a New Template 

To create a new DynacBudget or DynacViews template: 

1. On the left side of the window, select a company to display its list of 
templates in the pane on the right side of the window. 

2. Click anywhere in the gray area of the template pane, then click New and 
select either DynacBudget or DynacViews. 

Note The DynacViews option is available only if you purchased the 
DynacViews module. 

3. In the Add Dynac template dialog box, edit the default template filename 
then click OK.  The new template is added to the list of templates. 

Tip Dynac recommends that you name the template DynacViewsXX.xls, 
where XX is the last two digits of the fiscal year. 

4. Click the new template name, then click Open. 

Administering the Company Structure 
The Companies application allows you to define companies and their 
reporting structure.  If you are not familiar with the concept of companies, 
refer to Companies on page 2. 

You administer the company information using the Companies utility.  To run 
the utility, on the DynacCommand main menu, choose Tools > Companies. 
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Figure 23 – Companies window 

Creating a New Company 

Note Before creating a new company in the DynacCommand database, ensure 
that a SQL Server database has been created for the new company.  Contact 
either Dynac Support or your organization’s IT specialist to create the 
database and advice you about the database parameters required in Step 6. 

To create a new company: 

1. On the menu bar, click New to display the Add Company window. 

2. In the Add Company window, type an ID for the company, then click OK 
to display the Company Wizard window with the Company tab 
displayed. 

Note The company ID is created immediately in the Dynac database.  If you exit 
the editing window without entering all the required information, your 
DynacCommand window will display a new company entry in the list; 
however, it will not display a name.  You can later complete the company 
information as explained in Editing an Existing Company on page 26. 
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Figure 24 – Company Wizard window displaying Company tab 

3. In the Company Name field, enter the full company name. 

4. In the Consolidated checkbox, either leave it clear for an entity or click it 
for a consolidated company. 

5. Click Next to display the Database tab. 

Figure 25 – Company Wizard window displaying Database tab 

6. Click the browse button to locate the appropriate SQL Server database 
that was created for the new company, then enter the necessary 
information to connect to the database. 

Note If you are prompted to create a new database, choose No.  This version 
of DynacTools supports only SQL Server databases that have been 
created beforehand. 

7. Click Next to display the Templates tab. 
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Figure 26 – Company Wizard window displaying Templates tab 

8. In the Templates Folder field, click the browse button to locate the 
company folder or to create an appropriate company folder, then add the 
name for the company’s subfolder. 

Tip Dynac recommends using the company ID as the subfolder name (for 
example, CAD1, USD1, USDc, CADc, or ALLc). 

9. Click Finish. 

10. Close the Companies window. 

Note If you create a new company when there are existing user accounts, 
remember to update their access rights accordingly.  Administrator accounts 
are automatically updated. 

Editing an Existing Company 

To edit the information for an existing company: 

1. In the list of companies on the left side of the window, choose one by 
clicking on its ID.  Its information is displayed in the Properties tab. 
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Figure 27 – Companies window for an existing company 

2. On the menu bar, click Edit to display the Company Wizard window with 
the Company tab displayed. 

3. In the Company Name field, edit the full company name. 

4. In the Consolidated checkbox, either leave it clear for an unconsolidated 
entity or check it for a consolidated entity. 

5. Click Next to display the Database tab. 

Warning Do not edit database parameters except under the guidance of either 
Dynac Support or your organization’s IT specialist. 

6. Click Next to display the Templates tab. 

7. In the Templates Folder field, edit the path and name of the company 
templates folder.  Click the browse button to locate the parent folder, then 
add the name for the company’s subfolder. 

8. Click Finish. 

9. Close the Companies window. 

Tip In addition to using the Back and Next buttons to move between tabs, you 
can click the tab name to display it. 

Deleting an Existing Company 

Warning Be careful about deleting a company, particularly if it is part of a 
consolidation hierarchy.  Also, ensure that the company is not included 
in a scheduled event.  For instructions on deleting events, refer to  
Deleting an Event or a Set of Events on page 46. 

DynacCommand User Guide  27 



Tasks
 

To delete the information for an existing company: 

1. In the list of companies on the left side, choose one by clicking on its ID. 

 
Figure 28 – Companies window with a company selected 

Warning Review the information in the Properties tab to be certain that you 
selected the correct company. 

2. On the main menu, click Delete, then click Yes to confirm the deletion. 

3. Close the Companies window. 

Note The company information is only deleted from the DynacCommand menu.  Its 
information is retained in the Dynac Company database.  The application 
does not delete the company templates and the application does not delete 
the company information from the SQL Server database. 

Recovering a Deleted Company 

When you delete a company, DynacCommand only removes it from the 
display window – all company information remains in both its templates and 
its SQL Server database.  Therefore, you can easily restore the information 
provided that: 

(a) The company templates have not been deleted.  The company 
spreadsheet files are still located in the folder 
C:/DynacTools/Companies/AAAA, where AAAA is the ID of the 
deleted company. 

(b) The company database has not been deleted from SQL Server. 

If you have only deleted the company from DynacCommand, you can restore 
it to the DynacCommand menu by simply creating a new company with the 
identical company ID.  Follow the procedure for Creating a New Company on 
page 24. 
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Administering User Accounts 
The Users application allows you to administer user accounts.  If you are not 
familiar with the concept of user accounts, refer to User Accounts on page 5. 

You administer the company information using the Companies utility.  To run 
the utility, on the DynacCommand main menu, choose Tools > Users. 

Figure 29 – Users window 

Using the pre-defined admin administrator account, you can create other 
administrator accounts and other user accounts. 

Adding a User Account 

To add a new user account: 

1. On the left side of the window, click Add to display the Add User window, 
then do the following: 

2. In the Users window, type a user ID, then click OK. 

Note The user ID is what the person enters as their login username. 

3. In the Properties tab, do the following: 
i. In the Name field, type the user’s full name or identification. 
ii. In the New Password field, type a password. 
iii. In the Confirm Password field, re-type the password. 
iv. In the Administrator check box, do one of the following: 

• For an Administrator account, select the check box. 
• For a User account, leave the check box clear. 

4. In the Assigned Companies tab, select each company that the user can 
access. 
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Note By default, an Administrator user account can access all companies and 
those access rights cannot be changed. 

5. To save the information, do one of the following: 
• Click Apply to continue administering other user accounts. 
• Click OK to close the window. 

Editing an Existing User Account 

Note You cannot change the ID (that is, the login name) for an existing user 
account.  You must delete the account and create a new one. 

To change the information for an existing user account: 

1. On the left side of the window, click an existing user ID. 

2. To change the user information, select the Properties tab, then edit the 
appropriate fields (Name, New Password, Confirm Password). 

3. To change the company access information, select the Assigned 
Companies tab, then select or clear the check boxes for the appropriate 
companies. 

Note By default, an Administrator user account can access all companies and 
those access rights cannot be changed. 

4. To save the information, do one of the following: 
• Click Apply to continue administering other user accounts. 
• Click OK to close the window. 

Deleting an Existing User Account 

To delete an existing user account: 

1. On the left side of the window, choose an existing user ID. 

Warning Review the information in the Properties tab to be certain that you 
selected the correct user account. 

2. Click Delete, then click Yes to confirm the deletion. 

Note If you selected the wrong account or you did not intend to delete the 
account, click Cancel and the account will not be deleted. 

3. To save the information, do one of the following: 
• Click Apply to continue administering other user accounts. 
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• Click OK to close the window. 

The deletion takes effect the next time the user attempts to run DynacTools.  
That is, even if the user’s account is deleted, the person can continue to run 
DynacTools until they close their current session. 

Administering Chart of Accounts 
The Account Manager application allows you to organize the accounts from 
your accounting system into a structured CoA in DynacTools.  If you are not 
familiar with this concept, refer back to Chart of Accounts on page 6. 

Understanding the Account Manager Interface 

Figure 30 – Account Manager window 

There are seven areas in the Account Manager window. 

1. Program identifier. 
The information includes the name Dynac, the type of company that 
you selected (Entity or Consolidated), the program name (Account 
Manager), and the version of the program (0.27.0.105). 

2. Window operation buttons. 
Standard Windows buttons to minimize, maximize, and close the 
window. 

3. Main menu buttons. 

4. Account list areas. 
The pane  on the left (Unmapped Accounts) displays the posting 
accounts in your accounting system that have not been mapped to a 
CoA in the Dynac reporting structure.  The pane on the right (Chart of 
Accounts) displays the Dynac indented reporting structure.  You map 
a posting account to a Dynac CoA using an easy drag-and-drop 
operation. 
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5. Account properties areas. 
The area on the left displays the properties for an unmapped account.  
The area on the right displays the properties of a CoA item. 

6. Status bar. 
The status bar displays the current state of the application. 

7. Progress bar. 
Displays the progress of an activity. 

The functionality of the buttons is summarized in the following table. 
 

Location Button Name Description 

 
New Chart 
of Accounts 

Load a new CoA template file. 

 
Load Chart 
of Accounts 

Load Chart of Accounts information 
from the database.1

Main 
menu 

 
Save Chart 
of Accounts 

Save CoA structure to Dynac 
database. 

 
Collapse  
All 

Collapse all accounts to the parent 
entity. 

 
Expand  
All 

Expand all accounts to the lowest child 
levels. 

 
Save to  
File 

Save the account structure to a text 
file. 

 Properties Displays the Properties section at the 
bottom of the pane. 

both 
Account 
panes 

 
Search 
Account 

Find the next occurrence of the 
specified account2. 

Unmapped 
Accounts 
pane  

Find Next 
Unmapped 
Account 

Find the next posting account that is 
unmapped. 

 
Add New 
Items 

Adds a new account3. 

 
Delete  
Item 

Deletes an existing account. 

 Unmap Unmap an account from the CoA to the 
originating entity. 

 
Move  
Up 

Move accounts up in the hierarchy3. 

 
Move  
Down 

Move accounts down in the hierarchy3. 

Chart of 
Accounts 
pane 

  
Searches for the next account that 
does not have a Cash Flow code. 

Notes: 

1. When accounts are unmapped from the Chart of Accounts pane to the 
Unmapped Accounts pane, they remain listed in the order that they 
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were unlinked.  Use this button to reorganize the listing into their original 
order from the accounting system. 

Note Before reorganizing the listing, you must save any recent changes. 

2. The search algorithm does not support wild cards but it operates with an 
implied * wildcard at the end of the string.  For example, if you search for 
“11”, the search will identify accounts “1100” and “1110”.  However, it will 
not locate account “1011”. 

The search is performed from the current position in the pane to the end 
of the list of accounts.  Therefore, Account Manager will report that an 
item is not found if there are no further occurrences of it in the list even 
though there may be preceding occurrences. 

3. To move multiple posting accounts within their reporting group, click on 
the last one of the group, then depress and hold the Shift key and click on 
the first one of the group.  With the group highlighted, press the up or 
down arrow to move the group appropriately. 

Each account’s icon has meaning.  The icon has four attributes: shape, 
presence or absence of a number sign symbol (#), colour of the number sign 
symbol, and colour of the corner of the shape, as described in the following 
table. 

Note For the list of class codes, see Note 6 on page 11. 
 

Icon  Attribute Description 

 Single sheet 

Without a number sign symbol inside, it 
is a Header level (that is, class code 
“H”). 
With a number sign symbol inside, it is 
an account with class code “S”, “P”, or 
“D”. Shape 

 Multiple sheets 
Summary level account with child 
accounts.  It has a either a blue or red 
number sign symbol inside. 

 Blue 
The account is on the “prime” tree (that 
is, it is on a branch that reports to Total 
R, E, L, A, or Q). Colour 

of # 
 Red 

The account is not on the “prime” tree 
(that is, it is not on a branch that 
reports to Total R, E, L, A, or Q).1

 Blue A class “S” or “P” account. Colour 
of 
corner  Red A class “D” account. 
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Note: 

1. The Current Earnings account is not shown to be on the “prime” tree (that 
is, its number sign symbol is red) because it is a calculation account. 

For example, a  icon indicates a posting account (because of its single 
sheet shape and the presence of a number sign symbol) of class “D” 
(because of its red corner) that is on the “prime” tree (because of the blue 
colour of its number sign symbol). 

Understanding the Operation of Account Manager 

The Account Manager application maintains its information in the Dynac 
SQL Server database.  However, the application does not store the 
information in the database until you authorize it to do so with a save 
command.  Although the information will appear to change on the screen 
when you perform some operation, those changes are not immediately made 
in the database. 

This principle is important because it allows you to prevent mistakes from 
being stored in the database.  However, it also means that you must ensure 
that correct actions are saved to the database. 
• You can instruct Account Manager to save your changes using the Save 

Chart of Accounts button on the main menu. 
• On exit, Account Manager asks you whether or not you want to save 

your changes. 

 
Figure 31 – Account Manager exit warning 

Tip Save your changes frequently. 

Starting Account Manager 

To start Account Manager: 

1. On the DynacCommand main menu, choose Tools > Account Manager 
to display the Select dialog box. 

2. In the Select the company drop-down list, select a company name. 

Depending on the company you select, DynacCommand launches different 
Account Manager applications. 
• For an entity, the application is Dynac (Entity) Account Manager. 
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• For a consolidated company, the application is Dynac (Consolidated) 
Account Manager. 

Creating a New Chart of Accounts 

The way in which you create a chart of accounts is dependent on the type of 
company. 
• For an entity, use one of the sample Dynac CoA templates as an initial 

outline, then modify it to suit your requirements.  Refer to the next section 
Using a CoA Template File. 

• For a consolidated company, do both of the following: 
• Use one of the sample Dynac CoA templates as an initial outline, then 

modify it to suit your requirements.  Refer to the next section Using a 
CoA Template File. 

• Import the Charts of Accounts from its child entities.  Refer to Using 
Scheduler to Import a CoA on page 35. 

Note If you want to import a CoA from an external source, contact Dynac 
Professional Services to discuss your requirements. 

Using a CoA Template File 
To define a Chart of Accounts using a CoA template file: 

1. On the main menu, click New Chart of Accounts. 

2. In the Warning dialog box, click Yes. 

3. In the Open window, double-click one of the .coa template files. 

Modify the CoA structure to suit your requirements. 

Using Scheduler to Import a CoA 

Note This procedure is only applicable to a consolidated company. 

Because a consolidated company represents the total of two or more entities, 
it must contain the same Charts of Accounts that exist in each of its 
component entities.  To guarantee the accuracy of the CoA structure in the 
consolidated company, use the Scheduler tool to import the consolidated 
company’s CoA. 

Also, because the CoA structure could change in a component entity, you 
should re-import the consolidated company’s CoA before importing any D/L 
data into the consolidated company. 

Importing the CoA structure and the D/L data are independent events.  You 
do not need to import the CoA structure before importing the D/L data, but the 
CoA structure must be complete before all amounts can be displayed in 
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DynacBudget.  Therefore, for a consolidated company, it is best practice to 
use Scheduler to define two procedures for each of its component entities: 
• Import the entity’s CoA structure. 
• Import the entity’s D/L data  

If you are not familiar with the concept of scheduled events, refer to 
Scheduler on page 17. 

The following figure illustrates a sample scheduled procedure for 
consolidating six companies into one. 

 
Figure 32 – Sample consolidation event 

For the procedures on creating scheduled events, refer to Creating a Set of 
Events on page 44. 

Adding a New Chart of Accounts Item 

Note The application enforces certain rules for organizing the CoA.  If you are not 
familiar with the rules, refer to CoA Organization Principles on page 12. 

To add a new CoA item: 

1. In the Chart of Accounts pane, select the appropriate Header or 
Summary level that the new account will report to (that is, the parent of 
the new account). 

2. On the Chart of Accounts button bar, click Add New Item, then select 
the appropriate item (Header, Summary, or CTA). 

3. In the ID field in the dialog box, enter the account identifier, then click OK. 

If you are not adding a Header level, proceed to Step 5. 

4. In the RELAQ drop-down list of the Input dialog box, select the 
appropriate classification code, then click OK. 

5. If necessary, move the new account appropriately in the Chart of 
Accounts hierarchy.  See Moving a Chart of Account on page 37. 
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To complete the information for the new account, proceed to Editing a Chart 
of Accounts Item on page 37. 

Moving a Chart of Accounts Item 

Note The application enforces certain rules for organizing the CoA.  If you are not 
familiar with the rules, refer to CoA Organization Principles on page 12. 

To move a CoA item in the hierarchy: 

1. In the Chart of Accounts pane, select an item, then do one of the 
following: 
• Drag the item and drop it in a new location. 
• On the Chart of Accounts menu bar, click Move Up or Move Down 

until it reaches its new location. 

Editing a Chart of Accounts Item 

There are only three CoA parameters that can be edited, or changed: 
• Description  
• Cash Flow account code, and 
• Style display code. 

To edit a CoA item’s parameters: 

1. In the Chart of Accounts pane, select an item. 

2. In the Properties area, do one or more of the following: 

Note If the Properties area is not displayed, click Properties on the Chart of 
Accounts menu. 

• In the Description field, edit the text. 
• In the Cash Flow dropdown list, select a different account code. 
• In the Style dropdown list, select a different style code. 

Note For lists of Cash Flow and Style codes, refer to Default Cash Flow Accounts 
on page 52 and Default Styles on page 53, respectively. 

Mapping Accounts 

The mapping principles are the same for mapping accounts in an entity or in 
a consolidated company.  However, because a consolidated company allows 
additional grouping capabilities, the procedures are listed separately: 
• For mapping entity accounts, proceed to the next section Using Entity 

Account Manager. 
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• To map consolidated company accounts, proceed to Using Consolidated 
Account Manager on page 39. 

Note The application enforces certain rules for organizing the CoA.  If you are not 
familiar with these rules, refer to CoA Organization Principles on page 12. 

Using Entity Account Manager 
The posting accounts that originate in your accounting system do not have an 
organized structure.  Therefore, only individual accounts are mapped to the 
Dynac CoA. 

To map, or link, a posting account to a CoA item: 

1. Highlight an account in the Unmapped Accounts pane and drag it to the 
Chart of Accounts pane. 

6. Position the cursor on the appropriate Summary level, then release the 
mouse button. 

If it was not placed correctly, move it to its proper location.  See Moving a 
Chart of Accounts Item on page 37. 

Note As illustrated in the following figure, the cursor changes shape (from  to 

) when it passes over a valid location.  If you accidentally release the 
mouse button over an invalid location, the account returns to the Unmapped 
Accounts pane. 

Figure 33 – Mapping procedure 
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Note You can map a block of accounts by using the Shift key.  Click the first 
account, then press and hold the Shift key, then click another account to 
highlight multiple sequential accounts.  You can also Ctrl+click on non-
sequential accounts and move them as a block. 

To ensure that you have mapped all the posting accounts, do one of the 
following in the Unmapped Accounts pane: 
• Click Expand All.  No accounts should be displayed. 
• Select the uppermost level icon (that is, the company ID), then click Find 

Next Unmapped Account.  Account Manager should report No more 
accounts to be mapped.  Otherwise, it will highlight the first unmapped 
account. 

Also, if there are unmapped accounts, Account Manager displays a warning 
message when you exit the application. 

 
Figure 34 – Unmapped accounts warning message 

• Click Yes to continue in the application. 
• Click No to exit the application. 

Using Consolidated Account Manager 
The accounts in a consolidated company have an organized structure.  
Therefore, as you build the consolidated company’s CoA, you can choose to 
map either individual accounts or groups of accounts. 

Note If you are not familiar with the mapping concepts for consolidated companies, 
refer to Consolidated Company on page 14. 

To map, or link, either a posting account or a summary account to a CoA 
item: 

1. Highlight an account in the Unmapped Accounts pane and drag it to the 
Chart of Accounts pane. 

2. Position the cursor on the appropriate Summary level, then release the 
mouse button. 

3. For a Summary account, click Yes to confirm that you want to consolidate 
the child accounts into the summary account. 
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Figure 35 – Mapping reminder 

To ensure that you have mapped all the posting accounts, in the Unmapped 
Accounts pane, select the uppermost level icon (that is, the first company 
ID), then click Find Next Unmapped Account.  Account Manager should 
report No more accounts to be mapped.  Otherwise, it will highlight the first 
unmapped account. 

Also, if there are unmapped accounts, Account Manager will display a 
warning message when you attempt to exit the application. 

Unmapping an Account 

To unmap, or unlink, an account: 

1. Highlight an account in the Chart of Accounts pane, then click Unmap. 

The account is moved from the Chart of Accounts pane to the top of the 
Unmapped Accounts pane.  If you want to see the unmapped accounts 
listed in the way they were organized originally, refer to Note 1 on page 32. 

Deleting a Chart of Accounts Item 

To delete an account: 

1. In the Chart of Accounts pane, select one or more accounts. 

Note Use the Shift+click feature to select multiple accounts. 

2. On the Chart of Accounts button bar, click Delete. 

3. In the Confirm dialog box, click Yes to delete one account or Yes to All 
for multiple accounts. 

4. If the account has child accounts, in the Confirm dialog box, click Yes to 
delete the children on one account or Yes to All to delete the children on 
multiple accounts 

Note Child posting accounts are unmapped and displayed in the Unmapped 
Accounts pane. 
In a consolidated company, summary accounts are not deleted if they are 
Imported From a component entity or consolidated company.  Instead of 
being deleted, they are unmapped and displayed in the Unmapped 
Accounts pane. 
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Scheduling Events 
The Scheduler application allows you to automate events.  If you are not 
familiar with the concept of scheduled events, refer to Scheduler on page 17. 

Understanding the Scheduler Interface 

The Scheduled Events window has six areas: 
• calendar pane 
• events pane 
• event details pane 
• schedule bar 
• status bar 
• progress bar 

Figure 36 – Scheduler window 

There is no menu bar.  All operations are initiated by either clicking within a 
pane or on an event.  When you move the cursor into a new area, the mouse 
pointer briefly displays a reminder as to what action you should take. 
• In the events pane, the reminder is Right-click to edit. 
• In the events detail pane, the reminder is Double-click on name to edit. 
• On the schedule bar, the reminder is Double-click to edit. 
To start the scheduler application, on the DynacCommand main menu, 
choose Tools > Scheduler. 
There are various operations available in the events pane, as summarized in 
the following table. 
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Option Description 

Set of events Create a new set of events. 
New

Event Create a new event within a set of events. 

Rename Change the name of an event or a set of events.

Delete Delete an event or a set of events. 
Move Up 
Move Down Change the order of an event in a set of events. 

Validate Test the operation of an event or a set of events.

Run Now Run an event or a set of events immediately. 

Understanding the Operation of Scheduler 

The Scheduler application maintains its information in the Dynac database, 
DynacCommand.mdb.  However, the application does not store the 
information in the database until you authorize it to do so with a save 
command.  Although the information will appear to change on the screen 
when you perform some operation, those changes are not immediately made 
in the database. 

This principle is important because it allows you to prevent mistakes from 
being stored in the database.  However, it also means that you must ensure 
that correct actions are saved to the database. 

The Scheduled Events window displays three buttons that control when data 
is stored in the database. 

Figure 37 – Scheduler operation buttons 
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The operation of each button is described in the following table. 
 

Button Operation 

OK Exits the application and commits any pending user changes. 

Cancel Exits the application and rolls back any pending user changes. 

Apply Commits any pending user changes. 

Note If you exit the application by using the window’s Close button, Scheduler 
displays a dialog box asking you if you want to save any changes that you 
have made.  Clicking Yes is the same as using the OK button; clicking No is 
the same as using the Cancel button. 

The operations are best illustrated using simple examples simulating how you 
could edit the names of the three sets of events illustrated in Figure 28. 

To change the three names, you must perform three tasks.  Each example 
explains the result depending on how you use the Scheduler operation 
buttons. 

Note In all examples, the name will change in the events pane; the final result can 
be seen only after you close Scheduler and then re-open it. 

Example 1 – Change all names then press OK 
1. Perform 1st edit. 

2. Perform 2nd edit. 

3. Perform 3rd edit. 

4. Click OK. 

Scheduler closes and all names are changed in the database. 

Example 2 – Change all names then press Cancel 
1. Perform 1st edit. 

2. Perform 2nd edit. 

3. Perform 3rd edit. 

4. Click Cancel. 
Scheduler closes and no names are changed in the database. 

Example 3 – Click the Apply button after each change 
1. Perform 1st edit, then click Apply. 

2. Perform 2nd edit, then click Apply. 

3. Perform 3rd edit, then click Apply. 

4. Click Cancel. 
Scheduler closes and all names are changed in the database. 
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Note The Cancel button cancels only pending actions.  Because the Apply button 
committed each individual action, there were no pending actions that could 
be rolled back. 

For some operations, such as deleting a set of events, Scheduler displays a 
Confirm dialog box.  Even if you confirm the operation, the same principles 
apply and you must still commit the operation again by pressing either OK or 
Apply. 

Note These principles apply only to changes you are making to the events 
themselves; they do not apply to running the individual events.  The run 
operations perform actual data transfers that are independent of the other 
operations within Scheduler. 

Creating a Set of Events 

To create a set of events: 

1. In the events pane, right-click then choose New > Set of Events to 
display the New Events Set dialog box. 

2. In the Event Set field, type a description for the group, then click OK. 

Creating an Event 

Note You must create a Set of Events before you can create an Event. 

To create an event: 

1. In the events pane, right-click on an existing set of events, then choose 
New > Event to display the New Event dialog box. 

2. In the Type of action drop-down list box, select an action, then click OK. 

The new event is added to the end of the selected set of events.  By default, 
the event has a generic description.  To assign it an informative description, 
rename it by following the procedure described in section Renaming an Event 
or a Set of Events on page 46 . 

Before you can run the event, you must define its specific characteristics.  
Proceed to the next section Editing the Event Parameters. 

Editing the Event Parameters 

The event parameters depend on the type of event.  There are three types of 
events: 
• Import COA from Entity  
• Import DL from Entity  
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• Import GL from accounting system  

Tip In the Schedule Events window, the events detail pane contains three 
columns: Name, Data, and ID.  You may need to use the scroll bar to view 
the ID column.  You can change the width of the columns to fit within the 
pane. 

Import CoA or DL from Entity 
These operations transfer either the Chart of Accounts (CoA) information or 
the Detailed Ledger (D/L) data from an entity to a consolidated company. 

Two data parameters are required: 
• Source information 

The company ID of the entity.  In the events detail pane, the Name of the 
parameter is Entity Company ID and its ID is ETCompanyID. 

• Target information 
The location and name of the consolidated company’s budget file.  In the 
events detail pane, the Name of the parameter is Consolidator Dynac 
Budget file and its ID is HQTemplateFile. 

To edit the parameters for this event: 

1. In the events pane, click on an individual event to display its parameters 
in the Data column of the event details pane.  If the event has not yet 
been defined, the Data column is empty. 

2. In the Name column of the event details pane, double-click Consolidator 
Dynac Budget file, then browse to the appropriate budget file that is the 
source of the data. 

3. In the Name column of the event details pane, double-click Entity 
Company ID, to display the Select dialog box. 

4. In the Company drop-down list, select the ID of the company that the 
data will be transferred to, then click OK. 

Import GL from Accounting System 
This operation transfers actual General Ledger (G/L) data from your 
accounting system to an entity. 

Two data parameters are required: 
• Source information 

The database connection information to the accounting system. 

Note The source information is defined by Dynac Professional Services and is 
customized for your accounting system. 

• Target information 
The location and name of the entity’s budget file.  In the events detail 
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pane, the Name of the parameter is Entity Dynac Budget File and its ID 
is ETTemplateFile. 

To edit the parameters for this event: 

1. In the events pane, click on an individual event to display its parameters 
in the Data column of the event details pane.  If the event has not yet 
been defined, the Data column is empty. 

2. In the Name column of the event details pane, double-click Entity Dynac 
Budget File, then browse to the appropriate budget file that the data will 
be transferred to. 

Renaming an Event or a Set of Events 

To change the description for an event or a set of events: 

1. In the events pane, right-click on an individual event or a set of events, 
then choose Rename to display the Edit Name dialog box. 

2. In the Specify a name field, edit the description, then click OK. 

Deleting an Event or a Set of Events 

To delete an event or a set of events: 

1. In the events pane, right-click on an individual event or a set of events, 
then choose Delete. 

2. In the Confirm dialog box, click Yes. 

Note If you delete a set of events, its child events are also deleted. 

Reorganizing the Order of a Set of Events 

To change the order in which an individual event is executed with a set of 
events: 

1. In the events pane, right-click on an individual event, then choose either 
Move Up or Move Down to move the event one position in the list. 

Repeat the action until the event is organized appropriately in the list. 

Validating an Event or a Set of Events 

To validate, or test, the operation of an event or set of events: 

1. In the events pane, right-click on an individual event or a set of events, 
then choose Validate. 

The status bar displays the event that is being run and the progress bar 
indicates the duration of the process. 
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Scheduler tests the execution of the event or set of events and displays the 
results in the Events.log file that is automatically opened in the Notepad 
application. 

Note The results of the test are appended to the end of any existing results in the 
file.  Scroll down to the bottom of the file for the latest results. 

Running an Event or a Set of Events On Demand 

To run an event or set of events on demand, or immediately: 

1. In the events pane, right-click on an individual event or a set of events, 
then choose Run Now. 

The status bar displays the event that is being run and the progress bar 
indicates the duration of the process. 

Scheduler displays the results in the Events.log file that is automatically 
opened in the Notepad application. 

Note The results of the test are appended to the end of any existing results in the 
file.  Scroll down to the bottom of the file for the latest results. 

Scheduling a Set of Events to Run Automatically 

To schedule a set of events to run automatically: 

1. In the events pane, click on an individual event or a set of events to select 
it. 

Note Regardless of whether you select an individual event or a set of events, it 
is the set of events that is scheduled. 

2. On the schedule bar, double-click the default date and time to display the 
Edit dialog box. 

3. In the Events DateTime field, change the date and time appropriately, 
then click OK.  The format is MM/DD/YYYY HH:MM:SS in 12-hour 
format (AM or PM). 

The set of events is removed from list of events that you can run on demand.  
To view the event, click on the date when the event is scheduled to run.  The 
set of events will display with a clock icon instead of the folder icon, as 
illustrated in the following figure. 
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Figure 38 – Scheduled event indicator 

Updating DynacTools Software 
The software update process involves copying new files to replace the ones 
installed on your computer. 

Warning The update process requires an FTP Internet connection between your 
computer and the Dynac web site.  If your computer is protected by a 
firewall, the firewall may generate a warning or even block the file 
transfer. 

Before starting the update, ensure that the computer running the 
DynacUpdater wizard has closed all incidences of Excel and Dynac Account 
Manager.  Otherwise, the update process will not complete properly. 

To update your DynacTools software: 

1. On the DynacCommand main menu, choose Tools > Update to run the 
DynacUpdater wizard. 
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Note The DynacCommand application closes automatically.  It cannot remain 
active because it may require updating. 

2. Review the information on the Welcome window, then click Next to 
continue to the Authentication window. 

Note The wizard is pre-configured with a unique FTP user name for your 
implementation.  Do not change the default. 

3. In the FTP Password field, type the password for your implementation. 

4. Click Update to start the updating process. 

During the updating process, the Updating window is displayed. 

 
Figure 39 – DynacUpdater Updating window 

When the updating process is complete, the Completed window is 
displayed. 

DynacCommand User Guide  49 



Tasks
 

 
Figure 40 – DynacUpdater Completed window 

Review the results of the updating process to ensure that each item is 
reported as successfully updated.  To save the results, do one of 
the following: 
• Click Copy to copy the results to the clipboard. 
• Click Save to File to save the results in a text file. 

5. Click Finish. 

Obtaining Help 
To display the help options, on the main menu choose Help. 

 
Figure 41 – Help options 

Each option is explained in the following table. 
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Option Description 

Help  

What’s New Launches your default Internet browser and connects to 
the Dynac reference material web site. 

Dynac Home 
Page 

Launches your default Internet browser and connects to 
the main Dynac web site. 

Online 
Support 

Launches your default Internet browser and connects to 
the Dynac remote support web site. 

About Display the version of DynacCommand. 
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Chart of Accounts 

Default Cash Flow Accounts 
 

Code Description RELAQ 

CF0004 EARNINGS Q 

CF0005 AMORTIZATION A 

CF0008 ACCOUNTS RECEIVABLE A 

CF0009 GST RECEIVABLE A 

CF0010 INCOME TAXES RECEIVABLE A 

CF0011 INVENTORY A 

CF0012 OTHER WORKING CAPITAL ACCTS A 

CF0013 OVERDRAFT L 

CF0014 ACCOUNTS PAYABLE L 

CF0015 GST/SALES TAXES PAYABLE L 

CF0016 INCOME TAXES PAYABLE L 

CF0017 OTHER WORKING CAPITAL ACCTS L 

CF0020 LOANS / LONG TERM DEBT L 

CF0021 RELATED PARTY L 

CF0021 EQUITY Q 

CF0022 OTHER LIABILITIES L 

CF0023 DIVIDENDS Q 

CF0026 PURCHASE OF CAPITAL ASSETS A 

CF0027 LONG TERM INVESTMENTS A 

CF0028 OTHER ASSETS A 

CF0033 CASH ACCOUNTS A 

CF0034 RESOLVED CASH A 
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Default Styles 
 

Code Description Font Size Bold Sample 

1 Top Header Arial 12 Yes 123,456,789 
2 Normal Header Arial 10 Yes 123,456,789 

3 Account Arial 10 No 123,456,789 

4 Section Header Arial 20 Yes 123,456,789
5 0 - DynacChild Arial 10 No 123,456,789 

6 0.00 - DynacChild Arial 10 No 123,456,789.12 

7 Elimination Arial 10 No 123,456,789 
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